
Kentrol for Windows
 Help Topics

        Toolbar

        Tuner    Window 
Memories
Commands
Alphabetical List



Toolbar

        Source Buttons
          Store Buttons   

        Keyboard Tuning

        Split (txcvrs) or

        Power Switch (R-5000)

        Service Buttons

        Scroll

        Scanning Memory Channels

        Logging

        Transmit (txcvrs) or

        Time (R-5000)
Hot Spot Buttons ('50-series)



Memories
.KTS Files

Opening a .KTS File into an Editable Window
Scanning  a .KTS File
Saving A Memory Set Under a New Filename
Starting a New Memory List or File

To and From the Radio
Loading the Radio's Memory Channels from a .File Window
Reading the Radio's Memory Channels into the Available Channels Window

Scanning the Radio's Memory Channels
Selecting Channels to be Scanned
Setting the Scanning Rate
Scrolling through All occupied channels



Tuner Window
Tunable Source

Inactive Sources
S-Meter Display ('50-series)

Secondary Meter
Choosing a Spread

Wide 
1 MHz
Band
Sub
Defining your own Bands

Setting Frequency and Mode
Coarse Tuning
Fine Tuning
Ultra-Fine Tuning ('50-series)
 Jump: Up/Dn
Mode setting

Filter Selection ('50-series)
Incremental Tuning (txcvrs)

IT Setting
RIT 
XIT

Hot Spot Buttons ('40-series and R5000)
 



Commands
File 

Open Log
 Save
Memories

New List
Open File
File Scan
Save As
Read Radio
Load Radio
Setup Scan

Window 
Options:

Ultra-Fine Tuning ('50-series)
Configure

Default .KTS
Serial Port
UTC Offset
Ham Country
RTTY Frequency

Define User Bands
MW Step
Reset



Alphabetical List

Active Source
Antenna 1 / Antenna 2 (R-5000)
Coarse Tuning
Commands 
File Open Log
File Save
Filter Selection ('50-series)
Fine Tuning
Hot Spot Buttons
Inactive Sources
Jump: Up/Dn
Keyboard Tuning
Logging 
Memories 
Memories File Scan
Memories Load Radio
Memories New List
Memories Open File
Memories Read Radio
Memories Save As
Memories Setup Scan
Window Menu
Mode setting
Options - Configure - Default .KTS
Options - Configure - Ham Country
Options - Configure - RTTY Frequency
Options - Configure - Serial Port
Options - Configure - UTC Offset
Options - Define User Bands
Options - MW Step
Options - Reset
Options - Ultra-Fine Tuning ('50-series)
Power (R-5000)



RIT (txcvrs)
S-Meter Display ('50-series)
Scan
Scroll
Secondary Meter  ('50-series)
Service Buttons
Set IT  (txcvrs)
Split Operation (txcvrs)
Spread - 1 MHz
Spread - Band
Spread - Sub
Spread - Wide 
Store Buttons 
Time (R-5000)
Transmit (txcvrs)
Tunable Source
Tuner Window 
XIT (txcvrs, except TS-140S)



Transmit (Registered Copies Only)
        
Click the TX button to transmit.    The transmitter will stay on until you click the button again to 
return to receive mode or turn off the power.    When transmitting, the TX button turns red.

The hot key for Transmit is ctrl-T.

Related Topics

Tuner Window
Memories 
Split Operation



Split Operation (Registered Copies Only) 
        
Split operation is possible in VFO mode on all supported transceivers.    It is also available in 
Memory mode as follows:

TS-440S channels 90-99
TS-140S channels 10-19
TS-850S channels 00-89.

When you click the 'SPL' button in VFO mode, the Active vfo becomes the receive vfo and the 
Inactive vfo becomes the transmit vfo.    Both are now displayed in the Toolbar window, and 
indicated by the new face of the Split button.

When you select split while in Memory mode with a split-capable channel selected, both its 
receive and transmit settings are displayed and tunable.

To return to simplex operation, click the Split button again.    Until you toggle split off you 
will not be able to select a different source

The hot key for split operation is ctrl-P.

Related Topics

Tuner Window
Memories 
Transmit



Scroll
        
Steps the tuner scroll bar through its current range, tuning the Tunable Source.    You can change 
range, band or source while autoscrolling.    Uses Scan Pause setting if any.      Steps through all 
channels if MEM is tunable, ignoring any selected scan set.

The hot key for Scroll is ctrl-S.

Related Topics

Tuner Window



File Save
        
Updates a .KTS or .LOG file which is open in the active window. If the Available Channels 
window has the focus, this command creates the file DUMP.KTS overwriting any earlier dump.   
Otherwise, nothing happens. 

Related Topics

Memories



Time (R-5000)
        
Shows the current state of both radio clocks, plus system time.    Copy system time to Clock 1 or 
UTC to Clock 2 by clicking on a button, or enter times from the keyboard. 



Antenna 1 / Antenna 2 (R-5000)
        
Select either of the R-5000's two antenna terminals.    This setting applies to all three sources and 
is not saved to memory. 



Power Switch (R-5000)
        
Remote control of the R-5000's power on/off switch.    When the radio is on, the text of this 
button is red; when the button text is black, the radio is off and all other functions are disabled.    
When Kentrol starts up, it automatically turns your R5000 on if it is not already.

The hot key for the power switch is ctrl-P.



RIT (txcvrs)
        
Toggles RIT on and off.    This setting applies to all three sources and is not saved to memory.

The hot key for RIT is ctrl-R.

Related Topics

Coarse Tuning
Fine Tuning
Tuner Window



XIT (txcvrs, except TS-140S)
        
Toggles XIT on and off.    This setting applies to all three sources and is not saved to memory. 

The hot key for XIT is ctrl-X.

Related Topics

Coarse Tuning
Fine Tuning
Tuner Window



Set IT(txcvrs)
        
Shows the current IT setting and allows you to set it with a scroll bar. The Clear button sets the 
offset to zero.    This setting is used by both RIT and XIT.    They can be switched on and off 
separately, but cannot be set differently.

The hot key for IT setting is ctrl-I.

Related Topics

Coarse Tuning
Fine Tuning
Tuner Window



Spread - Wide
        
This is the default range.

The Coarse Tuning scroll bar tunes from 100 kHz to 29,999 kHz. Click its end arrows for 1 kHz 
steps, or the bar itself for 10 kHz steps. Jumping up or down (vertical arrow buttons) shifts the 
frequency by exactly 1 MHz.

Related Topics

Spread - 1 MHz
Spread - Band
Spread - Sub
Coarse Tuning
Fine Tuning
Tuner Window



Spread - Band
        
If the currently active frequency is within a band that Kentrol knows about, clicking on the Band
button sets the main scroll bar to the width of the band and labels it appropriately.    If you aren't 
within a recognized band, the bandspread defaults to Wide.

Click the end arrows for 1 kHz    steps, or bar for 10 kHz    steps.    

Bands are grouped into services.    Kentrol has several services built in:
broadcasting,
amateur,
time signals,
aeronautical (voice only),
marine (voice only), plus
a User service of up to 11 bands which you define.

Jumping goes to the next band up or down in the same service.    Kentrol remembers the last 
frequency you tuned before you changed bands and automatically restores it when you return 

Related Topics

Spread - 1 MHz
Spread - Sub
Spread - Wide
Defining your own Bands
Coarse Tuning
Fine Tuning
Tuner Window



Spread - Sub
        
The Sub button gives Kentrol control of mode and tuning step if clicked while you are tuned to a
frequency within a recognized band.    To change modes or tune between steps, click on one of 
the other Spread buttons.    

In the Ham, Aero and Marine services Sub also re-sets the main scroll bar to whichever sub-band
the current frequency falls within.      Sub-bands in the ham bands follow US/Can band plans for 
HF.      

Tuning step is 9/10 kHz in the MW broadcast band, 5 kHz in the SW broadcast bands, 3 kHz for 
Aero Route and Marine Phone sub-bands and 1 kHz elsewhere.    Clicking on the bar moves 10 
steps.    

Jumping up or down goes to the next matching sub-band within the current    service.      Kentrol 
remembers the last frequency you tuned before you changed bands and automatically restores it 
when you return    

Related Topics

Spread - 1 MHz
Spread - Band
Spread - Wide
Defining your own Bands
Coarse Tuning
Fine Tuning 
Tuner Window



Spread - 1 MHz
        
When you click this button, the Coarse Tuning bar's range becomes 1 MHz centred on the 
current frequency. For instance, if you are tuned to 14.260 and select the 1 MHz Spread, the 
range will be from 13.760 to 14.760. As in full range click the end arrows for 1 kHz steps, or the 
bar for 10 kHz steps.    Clicking the 1 MHz button again re-centers the scroll bar.    
Jumping up or down shifts the frequency and the tuning range by exactly 1 MHz, but it does not 
re-center the scroll bar.

Related Topics

Spread - Band
Spread - Sub
Spread - Wide
Coarse Tuning
Fine Tuning
Tuner Window



Jump: Up/Dn 
        
The vertical arrow buttons at both ends of the Coarse Tuning scroll bar allow you to jump up and
down the radio's frequency range. How jumping works depends on the Spread chosen.

When the Spread is Band or Sub, jumping is within the current service. Jumping up from the 
highest band loops to the lowest, and vice versa. Kentrol remembers the last frequency you tuned
before you changed bands and automatically restores it when you return 

When using the Wideband or 1 MHz Spread, the jump is up/down 1 MHz. The 1 MHz range is 
automatically shifted by the same amount.

The Jump buttons are not available  in memory mode.

Related Topics

Tuner Window
Coarse Tuning



Store Buttons
        
Below each of the source buttons on the toolbar is a small button marked "store".    Clicking on a 
store button copies the Tunable Source to the source on the button above.    It does not 
automatically make that source active.

When you store to MEM, the contents of the vfo are written to the current memory channel, 
overwriting any existing settings.    To copy to an empty channel, make MEM tunable and select 
the blank channel you want, then make the source you want stored tunable and store to MEM.

The hot keys for the store buttons are shift-ctrl-A, shift-ctrl-B and shift-ctrl-M.
 
Related Topics

Tunable Source
Tuner Window
Memories



Active Source 
        
There are 3 sources: (vfo) A, (vfo) B and M(emory).    The Active Source is the one you are 
listening to.    Select it with the big buttons at the left of the Toolbar.    The Spl(split) button 
makes the currently active source the Rx source for split operation.    Usually the Active source is
also the Tunable Source, but it need not be. 

Related Topics

Tunable Source
Inactive Sources
Split Operation
Tuner Window



 Inactive Sources
        
There are 3 sources: vfo A, vfo B and Mem.    The 2 that you are NOT listening to are the 
Inactive Sources.    In the tuner window you can tune an inactive source without making it active.
Just click its radio button  , making it the Tunable Source. 

Related Topics

Active Source
Tunable Source
Split Operation
Tuner Window



 Tunable Source 
        
There are 3 sources: vfo A, vfo B and Mem.    The source with its radio button ON is Tunable. 
The Tunable Source is controlled by the scroll bars in the Tuner Window.    By default the Active 
source is tunable.    To make another source tunable, click its radio button  .    

Related Topics

Active Source
Inactive Sources
Split Operation
Tuner Window



 Fine Tuning 
        
The main scroll bar tunes to 1 kHz resolution.    This bar fine tunes to 10 Hz. Click the end 
arrows for 10 Hz steps, or click the bar for 100 Hz steps. For 50-series radios, you can select 
Ultra-Fine Tuning  from the Options menu for steps of 1 Hz. and 10 Hz

When you get to either end of the fine tuning bar and click again, it moves the main (coarse) 
tuning bar one click and resets the fine tuning bar accordingly.    This allows you to cover as 
much of the spectrum as you want without having to coarse tune manually.

Fine Tuning is not active when MEM is the tunable source. 

The hot key for fine tuning is ctrl-F.

Related Topics

Coarse Tuning
Tuner Window
Ultra-Fine Tuning ('50-series)



 Keyboard Tuning 
        
The Keybd button opens a dialog box into which you enter the frequency or memory channel 
number you want.    When you hit < enter > or click the 'OK' button, the rig is instantly set to 
your selection.    Frequency can be entered in MHz, kHz or Hz, and Kentrol will figure out which
is which.    You can use as many or few decimal places as you want, with one exception; 
frequencies in MHz  must  be entered with a decimal point, because Kentrol assumes that any 
number below 100 without a decimal point    is a memory channel number.

If one of the vfos is active when you enter a frequency, that vfo is tuned to the new frequency.    
If you enter a frequency while Mem is active, the new frequency will be entered into vfo A, 
which will be made active.    

The hot key for keyboard tuning is ctrl-K.

Related Topics

Tuner Window



 Configure Set Default .KTS
        
The first time you run Kentrol, you will be required to accept a filename for the current contents 
of the radio's memory channels. Use the standard default.kts unless you already have one for 
another radio.    Kentrol will read your radio to this file the first time it runs and add its name to 
the 'load memories=' line of your kentrol.ini file. Thereafter, the file named on that line will be 
read each time Kentrol starts.

Related Topics

Memories



 K Configure UTC Offset
        
This number depends on your time zone and season.    Kentrol does NOT automatically allow for
daylight saving time.    Enter the number of hours your system time is ahead of, or behind UTC. 
Canada and the US are behind UTC so the offset to local time is negative (e.g.    EST = -5,      
PDT    = -7). If you have your system time set to UTC, the offset should be set to zero.

Related Topics



 Configure Serial Port
        
Use any port COM1 to COM4, so long as Windows knows where it is.    In Windows 3.0, this 
can be a problem for COM3 or 4, which Windows 3.0 (but not 3.1) expects at non-standard 
locations. If in doubt, use COM1 or 2. 

Related Topics



 Memories Open File
        
Select a memory set (.KTS) file and read its contents into a window. The memory set is NOT 
written into the radio automatically; use the Load Radio command to do that. Alternatively, you 
can tune to any frequency in the file by double-clicking its channel number, or use the File Scan 
command to scan them; these techniques do not load the frequencies into the radio's memories.

Related Topics

Memories



 Memories Save As
        
Saves the contents of a memory list window to a file.    A dialog box allows you to name/rename 
it. 

Related Topics

Memories



 Memories Load Radio
        
Loads the memory set in the current window into the radio and updates the 'load=' line in your 
kentrol.ini file to show the loaded file as your new default.

Related Topics

Memories



 Memories Read Radio

Reads the contents of the radio memories to an Available Channels Window, then gives it the 
focus.    You can control the radio from this window, provided that Memory is the current active 
source.    This command does NOT save to a file; use the Save command on the File Menu. 

Related Topics

Memories



 Memories New List
        
Opens an memory list window with 100 empty split-capable memories.    By default,    ...    is in 
the note field.

Related Topics

Memories



 Log Button
        
Adds records to a tab-separated ASCII text log file, named kentrol.log. This file can be read and 
edited with the Windows Notepad or any other plain text editor, as well as in Kentrol's log 
window. It can also be read and edited in a spreadsheet such as Excel, which will recognize it as 
a database and can convert the data to other formats.

UTC date and time, frequency, band and mode , plus signal on 50-series radios, are read directly 
from the radio by Kentrol. You are prompted for text, which you can organize into as many or as 
few fields as you want by using '\' as a separator. Kentrol converts the '\' to a tab, which Windows
won't allow you to type in directly.

 If a log edit window is open, it is automatically updated 

The hot key for logging is ctrl-L.

Related Topics



File Log Open
        
Opens the log file into an edit window.    You can copy, cut and paste to and from any other text 
window in Kentrol or another application.    You can paste log entries into a memory file. 

Related Topics

Memories



Scan Button
        
If you have selected a scan set with the Memories Setup Scan command, begins scanning with 
the last channel scanned, if any, else from the beginning 

The scan function is available only in Memory mode.    Otherwise the button is disabled.

The hot key for scan is ctrl-N.

Related Topics

Tuner Window
Memories



Memories Setup Scan
        
Opens a list of the Available Channels, from which you can select ANY combination using 
standard list box techniques.      Clicking OK with no channels selected selects all.    You can 
accept the default 2 sec pause or choose another.

Related Topics
 
Memories



Service Buttons

When you select a service (ham, broadcast, time signal, aero, marine, user-defined) Kentrol 
instantly takes you to it, by:

setting the active frequency to the beginning of the next band (up) of that service;
setting the active mode as appropriate for that frequency;
setting the Spread tuning range to Band.

From that point you can use the Jump buttons to move to higher or lower bands within that 
service, use the scroll bar to move to another part of the band, or choose Spread - Sub    and have 
Kentrol set the tuning step and mode.    (You'll probably want to move before choosing Sub in the
ham bands, unless you're a CW lover.)

Related Topics

Tuner Window



 Configure Ham Country
        
Ham bands are set by the ITU for whole regions, but it is left to national authorities to decide 
how they should be divided into sub-bands. Usually these are partly official (e.g. cw/phone) and 
partly voluntary (e.g. sstv/rtty). In Canada all ham sub-bands are voluntary.

So that Kentrol's Spread - Sub function can work properly in the Ham bands, it has to know 
which of its 2 built-in sets of ham sub-bands to use. The USA set, which is the default, largely 
follows the band plan recommended in the ARRL Operating Manual, 4th Edition.    The CAN set 
similarly follows the latest version of the CARF suggested band plan for HF. Where Kentrol 
differs from those plans is mostly in designating digital sub-bands. General practice is different 
from the ARRL/CARF plans, so Kentrol reflects general practice.

Related Topics

Memories



 Configure RTTY Tuning Frequency
        
In FSK mode (actually afsk), '40-series Kenwood radios display the imaginary carrier frequency 
just as they do in ssb modes.    The trouble is that nobody else does it that way, so to tune to a 
listed rtty frequency you have to apply an offset.    Kentrol allows you to tune any supported 
radio directly to listed frequencies!    

Just accept the default choice of MARK frequency in the configuration dialog box.    Now your 
Tuner Window and your log will show the Mark Tone frequency in FSK mode, and you'll be able
to tune directly to frequencies listed in magazines and books.    The front panel of a '40-series 
radio (or an R-5000) will continue to show the carrier frequency.

To have Kentrol display the same frequency as a '40-series radio, choose CARRIER.

The SPACE convention has been the standard for ham baudot code rtty, but seems largely to 
have been abandoned.

The MID frequency (centred between the tones) is the standard for MARS rtty and commercial 
SITOR frequency listings

Related Topics

Spread - Sub
Tuner Window



 Options MW Step
        
The medium wave broadcast band (am band) has 10 kHz channel spacing in most of the 
Americas (530, 540, 550...), but 9 kHz channel spacing (531, 540, 549, 558...) in most of the rest 
of the world.

This menu allows you to have Kentrol change its mw tuning step in Band and Sub modes to 9 
kHz for serious DXing.

Related Topics

Spread - Sub
Tuner Window



 Options Reset
        
If Kentrol gets 'out of touch' with your radio and shows ERR or 0's in the display, choose Reset.
This command causes Kentrol to query the radio twice for settings information as though it had 
been re-started, and will usually re-establish the link between computer and radio.

Related Topics

Spread - Sub



 Options Define User Bands
        
Kentrol permits you to define up to 11 bands of your own, which make up the User service.    
Once you have defined at least one band, the User-Defined item on the Service Menu gives you 
direct access.    With two or more User Bands defined, you can jump between them.

In the band-defining dialog box, you can choose a mode and either select one of the built-in 
tuning steps or specify your own, as long as it is a whole number of kHz.    The specified mode 
and step will be effective when the Spread is set to Sub.

It is important to note that User Bands take precedence over the built-in bands, so any ranges 
which overlap will function as though they were only in the User Band.

Related Topics

Spread - Band
Spread - Sub
Tuner Window



Hot Spot Buttons

Hot Spots are frequencies that you store temporarily for instant recall. Such short-term storage 
facilities are often called 'scratch' memories; on scanners they are usually called monitor 
channels. In Kentrol, they are stored in Hot Spot Buttons.

For '40-series transceivers and the R-5000, there are 8 Hot Spot Buttons located in the Tuner 
Window. For '50-series rigs, the Hot Spot Buttons are on the Toolbar.

In all cases, they work exactly the same way. When you click on a blank Hot Spot Button (or 
press its hot key combination) a dialog box opens, so you can enter a frequency. The current 
frequency is selected as the default, so you need only click 'OK' or press <enter> to accept it. The
current mode is automatically stored with the frequency. When you store a frequency it is 
displayed on the button.

To store a new frequency on a button that is already in use, first select it. Then when you click it 
a second time, the dialog box opens and you can type in the new frequency.

The hot keys for Hot Spot Buttons are ctrl + [1..8].

Related Topics

Tuner Window
Toolbar



Mode Setting ('50-series)

The edit window of the Mode combo box in the lower left of the tuner window always shows the
mode of the current tunable source. Clicking on the arrow beside the box opens the list of 
possible modes. Select the one you want via mouse or keyboard, then click the arrow again to 
close the list. If you prefer, you can just type the mode by name into the edit window and the 
selection will follow your typing.

The hot key for mode setting is ctrl-E.

Related Topics

Tuner Window



Filter Selection ('50-series)

On all '50-series Kenwood rigs, the IF filters can be selected via the computer, and the first (8 
MHz) and second (455 kHz) IF filters can be set independently of each other.

The edit windows of the two filter selection combo boxes show the filters currently in use. 
Changing filters is a simple matter of clicking on the appropriate arrow to open its list box, then 
clicking on your choice. The standard list box keyboard functions are available.

The hot keys for 1st and 2nd IF filters are ctrl + shift + [1,2].

Related Topics

Tuner Window



Coarse Tuning

The main scroll bar in the tuner window is used for coarse tuning. One step on this scale is 1 kHz
or more, depending on the bandspread chosen.    The current step is shown above the right (high) 
end of the scroll bar.    Like all tuner window actions, coarse tuning is applied to the tunable 
source.

The hot key for coarse tuning is ctrl-C.

Related Topics

Spread - Wide
Spread - 1 MHz
Spread - Band
Spread - Sub
Fine Tuning
Tuner Window



S-Meter Display ('50-series)

The meter display occupies the upper left of the tuner window when Kentrol operates a 50-series 
transceiver. Like the display on the radio's front panel, it is a segmented bar graph.

While in receive mode the meter shows signal strength on an S-unit scale. In transmit mode the 
meter shows Power in watts.

A secondary meter for transmit only provides additional information about your out-going signal.

Related Topics

Secondary Meter  ('50-series)
Tuner Window



Secondary Meter ('50-series)

The secondary meter display and the selected scale are visible only in transmit mode. The default
is no secondary meter, or 'off'. The other choices, available from the combo box, are a bar 
indicating the ALC range (for the power meter above) and bar graphs of SWR ratio or the 
amount of speech compression in dB.

Please note that there will be no reading for Comp unless speech processing is turned on. Also 
please note that SWR reading only works with the built-in antenna tuner switched off. These are 
hardware limitations.

Related Topics

S-Meter Display  ('50-series)
Tuner Window



Scanning a .KTS file

Once you have opened a .kts file, you can scan through it without having to load it into the radio 
first. There are some limitations compared to scanning the radio's memory channels: the rate is 
fixed at 2 sec. per channel and you can't select a subset of channels to scan. But loading the radio
is a slow process which has to be repeated to restore your default memory settings. For casual 
tuning around, scanning a file is more convenient.

From the Memories Menu select File Scan. If one of the vfos is active, it will be tuned instantly 
to the frequency and mode of the selected (highlighted) channel in the File Window. If Mem is 
active when you start, the radio will switch to vfo A before retuning. After 2 seconds the radio 
will retune up a channel and the display will scroll. After channel 99 it will automatically 
continue at channel 00

Stop scanning by clicking the very prominent Stop button or pressing <enter>. You can re-start 
where you leave off



Window Menu

The first command is either ToolBar or Fullsize, depending on which view is active. The 
Fullsize view is the one Kentrol starts in. The Toolbar view shows only the bar, taking up little 
screen space while providing key functions.

The Cascade and Tile commands re-arrange windows within the frame. They can be useful if 
you have a lot of memory files open, but they re-size the tuner and channels windows in ways 
that can make them difficult to use. The Arrange Icons command arranges the icons for any 
minimized Kentrol windows (such as memory file windows) at the bottom of the main Kentrol 
window.

At the bottom of the Window menu is the open windows list where the names of all open 
windows appear in a numbered list, with Available Channels as no. 1 and Tuner as no. 2. The 
quickest way to change windows is often to open this menu and click the desired name or type its
number.



Kentrol uses extended broadcast bands, based on the current edition of the World Radio-TV 
Handbook.



The following are built in: WWV/H at 2.5, 5, 10, 15, 20 Mhz and CHU at 3330, 7335, 14670 
kHz.



Ultra-Fine Tuning ('50-series)

The newest Kenwood models tune by direct digital synthesis (DDS), which allows them to tune 
in 1 Hz. steps. This high-resolution mode is enabled by the 'Fine' button on the front panel. The 
only catch is that, even though they tune in 1 Hz. steps, the radios display only 10 Hz. steps at 
best.

Kentrol gives you both 1 Hz tuning and 1 Hz display. Simply select the UltraFine command 
from the Options menu to toggle the 1 Hz mode on and off. When the command is checked 
frequencies are displayed in Hz. and the Fine Tuning scrollbar moves in 1 Hz. steps

Related Topics

Coarse Tuning
Tuner Window
Fine Tuning


